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ADCA (Advance Diploma in Computer Application)

Semester-1 Semester-2
» Computer Concept & Fundamentals > Adobe Page Maker
» Operating System » Photoshop
% Windows » Project & Practical
% Android » Corel Draw
» MS Office » Type Master
% MSWord » BengaliType
% MS Excel » Tally Prime
% MS Power Point » GST
» Email & Internet Technology

> Practical

DSPP (Diploma in Secretarial Practice & Publishing)

Course Code :B12 Eligibility :10th

Semester-1 Semester-2
» Computer Concept & Fundamentals » Financial Account with Tally
» Operating System Prime
% Windows » Email & Internet Technology
% Android » DT.P
» MS Office % Page Maker
% MSWord % Corel Draw
% MS Excel % Photoshop
% MS Power Point » Project & Practical

Programmingin C
Practical




Course Code :B16

Duration:6/122 M

DIT (Diploma in Information Technology)

Eligibility :10th

» Computer Concept & Fundamentals » Email & Internet Technology
» Operating System »> Regional Language

% Windows » Project & Practical

% Android » HTML
» MS Office » Photoshop

% MSWord

% MS Excel

X/

»*  MS Power Point

DDTP (Diploma in Desk Top publication)

Course Code :Ba2

> DTP » Type Master
% Page Maker » BengaliType
% Corel Draw
% Photoshop

GCRAPHIC
DESIGNING




DCA (Diploma in Computer Application)

Course Code :B14

>
>

Operating System
%  Windows
+ Android

MS Office

¥ MS Word

X S Excel

e M
® MS Power Point

*

Y

X/
*

X/
*

X/
*

Computer Concept & Fundamentals >

>
>

Financial Account with Tally Prime
Email & Internet Technology
Practical

N

ADIT (Advance Diploma in Information Technology)

Course Code :B1y

>

> Computer Concept & Fundamentals »

» Operating System
<  Windows
< Android
» MS Office
< MSWord
s MS Excel
«* MS Power Point

VVVYVYVYVYVY

Email & Internet Technology
Regional Language

Project & Practical

JAVA

MY SQL

HTML

DHTNL

C++




DDSE (Diploma in Desktop Support Executive)

Course Code :H12 Eligibility :10th

Introducing to PC Hardware

Hardware Installation & Configuration
Troubleshooting & Maintenance of Basics
Software Installation & Configuration (OS —XP, 7)
Basic Electrical & Electronics

Computer Organization, Microprocessors & Memory Basics

PC Assembling & Troubleshooting

Understanding Portable Systems, Laptop, Tab etc. (Only Theoretical)
Configuring Windows 7

Windows 7 Enterprise Desktop Support Technician

Linux OS Installation Part-1

VVVVVVVVVVYY

DWD (Diploma in Web Designed)

Course Code :M11 Duration :6 M Eligibility :10th

» Computer Concept & Fundamentals > In Design

» Operating System »  Gif Animation

» Flash » Fire Work

» Dreamweaver » Project & Practical
» lllustrator




VIDEO EDITING

> Adobe Premier > Gif Animation
» Sound Forge > Effect
> FILMORA

DPMO (Diploma in Professional Multimedia Operation

Semester-1 Semester-2

» Computer Concept & Fundamentals » Dreamweaver
» Operating System > lllustrator
% Windows > InDesign
% Android »  Gift Animation
» DTP »  Fire Work
% Page Maker »> Adobe Premier
% Corel Draw » Soundforge
% Photoshop » FreeHand
» Flash » Project & Practical

» Project & Practical
Semester-3

» Story Boarding
> 3D MAX
> Effect
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ADFA (Advance Diploma in Financial Accounting)

Duration:12 M

Course Code :FA15

Eligibility :12th

» Computer Concept & Fundamentals » Taxation
» Operating System » Company Law
s Windows » Banking
% Android » Insurance
» Basic Computer » Port Folio Management
» Basic Accounting » Cost-Accounting Company Law
» MS Excel » Auditing
» Tally Prime » E-Banking IS B
> GST —er .

DPCA (Diploma in Professional Computer Accounting)

Course Code :FA11 Eligibility :12t

Semester-1 (3 Months) Semester-3 (4 Months)
» Basic Computer » Taxation
» Basic Accounting % DirectTax

X/

Semester-2 (6 Months) % IndirectTax

» Tally Prime i ;:mji)r?ny Ly
-y > Insurangce
» Advance Excel .

» PortFolio
» Advance Internet

Management
Semester-4 (5 Months) »  Cost-Accounting
» E-Banking » Auditing
» Share Market, Money Market, Capital
Market

» ShareTrading
» E-Filling Of Tax
» ROC




Tally Prime

GST

Advance Excel
Advance Internet

VVVY

DMTG (Diploma in Master Tally & GST)

Certificate Course

Certificate in Tally (S 11)
Certificate in GST

Certificate in Auditing (S 13)
Certificate in MS Excel (S 15)
Certificate in Auto CAD (S 17)
Certificate in Animation (S 19)
Certificate in Hardware (S 21)

YVVVYVYVYYVY

POWER OF SIMPLICITY
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Certificate in Web Technology (S 23)
Certificate in Taxation (S 12)
Certificate in E-Banking (S 14)
Certificate in JAVA (S 16)

Certificate in Multimedia (S 18)
Certificate in E-mail & Internet (S
20)

Certificate in E-Commerce (S 22)




DIPLOMA IN OFFICE APPLICANT & PUBLISHING
4

Fundamental of Computer

Operating System (Windows & Android)

DOS

Number System (Binary, Octal, Decimal, Hexadecimal)
MS Paint

WordPad, NotePad

Concept of Control Panel \ J
MS Office (Word, Excel, Power Point)

Advance Internet

Hardware Concept

Hdd Format & OS Installation

Software Installation & Anti Virus Concept

Corel Draw, Page Maker, Photoshop g
Bengali Typing

Printing & Scanning

CD Making

Accounting Fundamental

Computerized Accounting —Tally Prime with GST
Project

ADVANCE DIPLOMA IN OFFICE APPLICANT & PUBLISHING

~

Install...

VYVVVVVVYVYVYVYVVYVVYVVY

DOAP+

HTML

ONLINE MARKETING
ONLINE BUSINESS
GOOGLE BUSINESS
FACEBOOKADD
MS-ACCESS
MS-OUTLOOK

YVVVYVYVVYVYYVY
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>
>

Operating System
s Windows

DCTT (Diploma in Computer Teacher Training)

Computer Concept & Fundamentals

Programmingin C ++
Children Psychology
Methods of Teaching

Eligibility :10t™

>

>

>

< Android >
» MS Office

< MS Word

% MS Excel
% MS Power Point

Personality Development

4 )

E-mail & Internet Technology
School Organization & Admission
Practice

YV V V

» Computer Concept & Fundamentals
» Operating System
% Windows
¢ Android
» MS Office
% MSWord
s MS Excel
% MS Power Point
Programming in C+
E-mail & Internet Technology
Project & Practice

Eligibility :10th
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CIT (Certificate in Information Technology)
Course Code :C11 Eligibility :10th

» Computer Concept & Fundamentals
» Operating System

*  Windows A N , _
> MSOffice i Information
% MSWord ;! Technology

-

s MS Excel
s MS Power Point

DCAD (Diploma in Computer Application & Designing)

Computer concept & fundamentals
0osS
MS Office
s Excel
Word

Power point

YV V V

X/
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Page Maker
Corel Draw
Photoshop

X/
L X4

X/
L X4

» project




CDTP (Certificate in Desk Top Publication)

Course Code :D13 Eligibility :10t

S

» Page Maker Tg_ iy,
» Corel Draw DESKL';)F,_J,U!;.)SH.NG
» Photoshop ﬁl @® E

DAT (Diploma in Advance Taxation)

Course Code :FA13 Eligibility :10t™

Taxation

Company law

Banking Insurance

Port Folio management
Cost-Accounting
Auditing

VVVYVYVYVY




DMT (Diploma in Master Tally)

Course Code :FA12 Duration :6 M Eligibility :10th

» Tally Prime
> Advance Excel
> Internet POWER OF SIMPLICITY

= o &—=
—

Diploma in E-Banking & ROC

Course Code :FA14 Duration :6 M Eligibility :10th

E-Banking
Share Market : S e
Money Market RS W
Capital Market E—B‘&“\t\\ \
Share Trading IS :
E-Filling of Tax
ROC

VVVVYVYYVYY




DAC (Diploma in Auto Cad)
Course Code :D16 Eligibility :10t™

Giias d;‘\\\/:://\ .
» Computer Concept & Fundamental r‘ﬂ‘.‘\@‘ i‘l\“\is&‘\\;iuf
» 0OS Concept L \‘9{‘% m”%
» AutoCad2D \ ,i’H\L
> Basic Auto Cad 3D s 1 folegid
A

DS (Diploma in Solidworks)

Course Code :D18 Eligibility :10th

» Advance 3D Solidworks




DJC (Diploma in Jewellery Cad)

RHINO
MATRIX
AUTO CAD

YV V

DAIM (DIGITAL ANDROID INDIA MISSION 2020)

Course Code :DAI20 Eligibility :10th

Internet Concept
Android Concept
Online Banking , Mobile Banking
Online Money Transfer

Online Account Opening

Paytm, Flipkart, Amazon etc.

Mobile Recharge , Electric Bill Payment
Google Maps, Ola, Uber etc.

Safety & Security
Play Store

Many More...

VVYVVVYVVVYVY
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DIDD (Diploma In Interior Design & Decoration)

Course Code :DE11 Duration :24 M Eligibility :10th

» Appraise And Understand Importance Of Interior Designing & Drawing
Instruments, Drawing Sheet

» DraftThe Geometrical Shapes And Projection With The Help Of Engineering

Scale And Free Hand Sketched

Draft The Design With The Help Of Color Scheme And Apply With Rules And

Calculations

Draw Residential Plan With Necessary Working Drawing.

Draw Different Types Of Staircase.

Basic Knowledge Of Structural Part Of Building.

Draw Doors And Windows & Details.

Draw One And Two Points Perspective View.

Prepare Power Point Presentation With Animation.

Create Object On 3D Using Tool Bars, Commands.

Draw Different Types Of False Ceiling By Using CAD.

Draw Different Types Of Flooring By Using CAD.

Draw Different Types Of Carpentry Joints By Using CAD.

Analyze And Uses Of Paints, Polish And Varnish.

Draw Different Types Of Partition Wall By Using CAD. e

Draw Plumbing And Drainage Details And Sanitary Fittings By Usmg CAD

Draw Lighting And Electrical Layout Plan By Using CAD.

Draw Air Conditioning Layout By Using CAD.

Draw Commercial Interiors By Using CAD.

Project

Y
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Certificate in E-Commerce

> Certificate in E-
Commerce

Course Code :ECa12 Eligibility :10th
AARA I
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CDS (Certificate Desktop Support)

>
>
>

>

Eligibility :10th
Introducing to PC Hardware 7,&‘\-\-3_\{,
Hardware Installation & Configuration %\(%‘\?—V\ J
Troubleshooting & Maintenance of — —
Basics
Software Installation & Configuration

(OS-XP, 7)

DNSE (Diploma in Network Support Executive)

Course Code :HN11

VVYVVYVVYYVY

>
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>
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Eligibility :10t™

Introducing to PC Hardware

Hardware Installation & Configuration
Troubleshooting & Maintenance of Basics
Software Installation & Configuration (OS-XP, 7)
Basic Electrical & Electronics 4
Computer Organization, Microprocessors & Memory Basics
PC Assembling & Troubleshooting

Understanding Portable Systems, Laptop, TAB etc. (Only
Theoretical)

Configuring Windows 7

Windows 7 Enterprise Desktop Support Technician

Linux OS Installation Part-I

Configuring Window Server 2008/2012 Active Directory Configuring
Window Server 2008/2012 Network Infrastructure
Window Server 2008 Server Administration
Understanding Basic of IT Service Management




DENA (Diploma in Enterprise Network Administrator)

Course Code :HN12 Eligibility :10th

Introducing to PC Hardware

Hardware Installation & Configuration

Troubleshooting & Maintenance of Basics

Software Installation & Configuration (OS-XP, 7)

Basic Electrical & Electronics

Computer Organization, Microprocessors & Memory Basics

PC Assembling & Troubleshooting

Understanding Portable Systems, Laptop, TAB etc. (Only Theoretical)
Configuring Windows 7

Windows 7 Enterprise Desktop Support Technician

Linux OS Installation Part-I

Configuring Window Server 2008/2012 Active Directory Configuring
Window Server 2008/2012 Network Infrastructure

Window Server 2008 Server Administration

Understanding Basic of IT Service Management

Understanding Cisco Networking Devices (ICND-1)

Administration of Cisco Networking Devices (ICND-2)

Linux OS Installation Part-Il (RHCE-II)

VVYVVVVYVYVYVYVVYVVYVYVYVYY




DNE (Diploma in Network Experts)

Course Code :HN13

Introducing to PC Hardware

Hardware Installation & Configuration

Troubleshooting & Maintenance of Basics

Software Installation & Configuration (OS-XP, 7)

Basic Electrical & Electronics

Computer Organization, Microprocessors & Memory Basics

PC Assembling & Troubleshooting

Understanding Portable Systems, Laptop, TAB etc. (Only Theoretical)
Configuring Windows 7

Windows 7 Enterprise Desktop Support Technician

Linux OS Installation Part-I

Configuring Window Server 2008/2012 Active Directory Configuring
Window Server 2008/2012 Network Infrastructure

Window Server 2008 Server Administration

Understanding Basic of IT Service Management

Understanding Cisco Networking Devices (ICND-1)
Administration of Cisco Networking Devices (ICND-2)

Linux OS Installation Part-Il (RHCE-II)

Linux OS Installation Part-Il (RHCE-III)

IT Security (Just Concept, No Practical)

Storage Fundamentals

Installing, Configuring & Configuring Exchange Server 2007/2010

Eligibility :10t™

VVVVVYVYVVVVYVYVVYVYVYVYVVVYVYYY



ADCJM (Advance Diploma in Computer for Junior
Master (Level-1)

Course Code :J11 Eligibility :10th

Computer Concept (Theory)

Mouse, Key Board, Speaker, Head Phone, Printer, Scanner, Joystick, Monitor,
C.P.U etc. (Practical + Theory)

Computer On/Off (Windows XP, Windows 7, Windows 8)
MS Paint

WordPad, NotePad

Windows Media Player, Sound Record etc.

Change Desktop Background, Change Screen Sever (Windows XP, 7, 8)
Type Master, Folder

File Making, Cut-Copy-Paste

YV VY

VVYVVYVVY

ADCJM (Advance Diploma in Computer for Junior
Master (Level-2)

Course Code :J12 Eligibility :10th

OS Concept (Windows-7, Windows-8) (Theory)

MS Word, MS Excel

Concept of Pen Drive, Sound System (Advance)
Printer (Advance) etc.

Concept of ‘Control Penal’, Concept of System Tools
Transfer Folder & File

Delete & Restore

VVYVVYVVY




ADCJM (Advance Diploma in Computer for Junior
Master (Level-3)

Course Code :J13 Eligibility :10th

MS Power Point

Bengali/Hindi typing (Practical & Theory)
Concept of RAM, ROM, HDD, CPU, ALU, DVDRW, Mother Board
LOGO

Internet

Typing Master

Concept of Hardware & Software
Advance Control Penal
Accessories Menu

VVYVVYVYVVVYVY

ADCJM (Advance Diploma in Computer for Junior
Master (Level-4)

Course Code :J14 Eligibility :10th

MS Excel (Advance)

MS Access, MS-Outlook

Basic Programing

Logic Gate

Decimal, Binary, Octal, Hexa-Decimal

Convert Binary to Decimal & Decimal to Binary
Advance Internet (Practical & Theory)

MS Power Point Project

VVVYVYVVYYYVY




ADCJM (Advance Diploma in Computer for Junior
Master (Level-5)

Course Code :J15 Eligibility :10th

- =
Programming ) ot
Concept "
HTML
VB
Programming C
Advance Control
Panel

CJ (Certificate In Junior Level 1)
Course Code :JL50 Eligibility :10th

Computer Theory

Familiar with Mouse

Familiar with Keyboard (Typing)
Tux Paint

MS Paint (Part-1)

TUXType (Part-1)

Y

YV VY
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CJ (Certificate In Junior Level 2)
Course Code :JL51 Eligibility :10th

Computer Theory
Tux Paint

Typing in Notepad
MS Paint

Tux Type (Part-2)
Tux Math (Part-1)

CJM (Certificate In Junior Master Level 1)

Computer Theory
Tux Paint

Tux Type

Tux Math

Note Pad

Word Pad

MS Paint

LOGO (Level-1)

VVVVYVY
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CJM (Certificate In Junior Master Level 2)

Course Code :JL53 Eligibility :10th

Computer Theory
Tux Type

Tux Math

Note Pad

Word Pad

MS Paint

LOGO (Advanced)
DOS (Part 1)

Color Paint (Linux)

VVVVYVYVVYVYVY

CSL (Certificate In Senior Level 1)

Course Code :JL54 Eligibility :10th

Computer Theory

Note Pad

Word Pad

MS Paint

MS-DOS

Color Paint (Linux)

Color Geography (Linux)

MS Word 2007/2010|(Type/Table
Making/Word Art/Picture/Clip Art etc.)

VVVYVYVVYVYYY




CSL (Certificate In Senior Level 2)
Course Code :JLsg Eligibility :10t™

Computer Theory

Note Pad

Word Pad

MS Paint

MS-DOS

Color Paint (Linux)
Color Geography (Linux)
MS Word 2007 (Type/Table Making/Word Art/Picture/Clip Art etc.)
Bengali Type

Scratch Program

MS Word 2010

MS Excel Level-1

CSL (Certificate In Senior Level 3)

» ComputerTheory + Binary
Calculation

Bengali Type

MS Word 2010

MS Excel Level-2 ' AN

VVYVVVVYVYYVYVVYVVYY
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CSML (Certificate In Senior Master Level 1)

Course Code :JL57 Eligibility :10th

Computer Theory + Binary
Calculation

Bengali Type

Power Point

MS Excel Level-3

Page Maker

Internet

MS Word 2013

A\

VVYVVYVY

CSML (Certificate In Senior Master Level 2)

Course Code :JL58 Eligibility :10t™

Computer Theory + Binary
Calculation

Bengali Type

Power Point

Corel Draw

Page Maker

Internet

MS Word 2013

MS Access

A\
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CJML (Certificate In Junior Master Level 3)
Course Code :JLgg Eligibility :10t™

Computer Theory + Binary Calculation
Bengali Type

Photoshop

Corel Draw

Page Maker

Internet

MS Access

Diploma in 3D MAX

» Computer Concept & Fundamentals
» Operating System
> 3D MAX

YVVVVYVYVYY




DMO (Diploma in Multimedia Operation)

Course Code :M1g

YV VY

VVVVYYVY

Computer Concept & Fundamentals
Operating System
¢ Windows

¢ Android
Page Maker
Corel Draw
Photoshop

MULTIMEDIA

Flash
Project & Practical

VVVYVVVYVYVY

Eligibility :10th

Dreamweaver
[llustrator
InDesign

Gif Animation
Fire Work
Adobe Premier
Sound Forge
Free Hand
Project

MP (Multimedia Pro)

Course Code :M21

Graphics + 2D + Basic 3D + VFX

Software Covered -Nuke, Silhouette, Mocha,
Fusion, After effects, Maya, Z Brush, Graphics (full),
3D Equalizer, Premiere Pro, Animate CC.

I | ¥
MEDI
iy

."" "

—M

Q

Eligibility :10th



DVP (DIPLOMA IN VEX PLUS)

»  Graphics + VFX
»  Software Covered -Nuke, Silhouette, Mocha, Fusion,
After effects, Premiere Pro, Graphics (full), 3D Equalizer

DIPLOMA IN 3D PLUS

» Syllabus Covered- Graphics + 3D
» Software Covered - Maya, V-Ray, Z Brush,+ Graphics (full), Premiere Pro




DAM (Diploma In Advance Multimedia)

Course Code :M24 Eligibility :10th

B <) IR 8
> Theory + Basic 3D (4 months) + Adv 3D + @ . AR
VFX Software Covered — Graphics (2 JLII

» Syllabus Covered - Graphics + 2D + Film

months) + 2D (2 months) + Film —Theory Q AMU

(2 months) + Basic 3D (4 months) + Adv
3D (5 months) + VFX (5 months)

DMM (Diploma in Mobile Maintenance)

Course Code :MM11 Duration :6 M Eligibility :10th

Hardware : Software :

Basics of Mobile Communication

Tools & Instruments Used in Mobile Phone
Repairing

Various Components Used in Mobile Phones
Basic Parts of Mobile Phones (Mic, Speaker,
Buzzer, LCD, Antenna, etc.)

Use of MultiMate

Use of Battery Booster

Basic Circuit Board/ Motherboard Introduction
Assembling & Disassembling of Different
Mobile Phones

Soldering & Disordering Components Using
Different Soldering Tools

Names of Different ICs

Work of Different ICs

Working on SMD/ BGA ICs and the PCB
Fault Finding & Troubleshooting

Jumping Techniques

Troubleshooting Through Circuit Diagrams
Repairing Procedure for Repairing Different
Hardware Faults

Flashing
Formatting
Unlocking

Use of Secret Codes
Downloading
Bluetooth/ Infrared

>
>

vV VY
VVVVYVYY

YV VY
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ADMM (Advanced Diploma in Mobile Maintenance)

Diploma in Mobile Maintenance+

Charging Section

Network Section

Keypad Section

Display Section

Speaker and Ringer Section
Blue Tooth Section

Infra Red Section

Light Section

Different Type of Android & Windows Mobile DE Assembling & Assembling
Android & Windows Mobile Fault Finding & Troubleshooting

Android & Windows OS Reset

Android OS Installation

Use of Secret Codes

ADWC (App Development without Coding)

VYVVVVVYVVVYVVYYVY

Course Code :P21 Eligibility :10th

» Android App Development without

Coding

AN

No-Code App Development

The simplest and most complete guide to no-code app development

a3




CT (Certificate in Tally)

Course Code :511 Eligibility :10th

» Computer Concept & Fundamental

»  Operating System N oy Prime
» Tally Prime

Cl (Certificate in Internet)

Course Code :S12 Eligibility :10t™

» Computer Concept & Fundamental
» Internet & Email Technology

-
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&)
CAE (Certificate in Advance Excel)

Course Code :S13 Eligibility :10t™

Basic MS Excel
Vlookup
Hlookup
Pivot Table
Macro
Hyperlink
Advance Filter
Protect Sheet

CT (Certificate in Taxation)

» Computer Concept & Fundamental
» Operating System

Advance Excel

VVVVYVYVYVYY

Course Code :S14 Eligibility :10t™

» Computer Concept & Fundamental
» Operating System
» Taxation




)
CA (Certificate in Auditing)

[7/]

Eligibility :10th
, tvﬁ‘\l\'lﬂﬁ\': e ufvi :"\’ o)

» Computer Concept & Fundamental
» Operating System
» Auditing

2 Beand
Performance

Finance & Pro

AUDITING

e 3 5%“;00\““6/:;’/
| y 3 %\\ =
e § I R a&\\ﬁf‘\\\x\\\\‘\“
Certificate in E-Banking
Course Code :S16 Duration :3 M

» Computer Concept & Fundamental
» Operating System

>
Sue
Q@\\\‘W
2,
Z
2
[
Z,
Z

%7 \\\\

Eligibility :10th
» E-Banking




Certificate in C

Course Code :S17 EI|g|b|I|ty 10th

» Computer Concept & Fundamental
» Operating System Programs
> C

Certificate in C++

Course Code :518 Eligibility :10t™

Computer Concept & Fundamental
Operating System
C++

YV V
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Certificate in JAVA

Course Code :S19 Eligibility :10t™

» Computer Concept & Fundamental . s e
» Operating System :
> JAVA o

Certificate in Auto CAD

Course Code :S20 Eligibility :10t

» Computer Concept & Fundamental
» Operating System
» AUTOCAD




Certificate in GST

Course Code :S521 Eligibility :10t

CTT (Certificate in Typing Test)

Course Code :S25 Eligibility :10th

» Computer Concept & Fundamental
» TypingTest




CBT (Certificate in Bengali Typing)

Course Code :S30 Eligibility :10t™

» BengaliTyping

Certificate in HTML

Course Code :532 Eligibility :10t™

» HTML
» CSS
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Certificate in PYTHON

Course Code :SP Eligibility :10t

» PYTHON Language

Assistant Nursing and Midwifery (Vocational Course)

Course Code :VC51 Eligibility :10t

» BioSciences
¢ Anatomy & Physiology
% Microbiology
» Behavioral Sciences
% Psychology
¢ Sociology
» Nursing Foundations
¢ Fundamentals of Nursing
¢ Firstaid
Community Health Nursing
Environmental Hygiene
Health Education & Communication Skills
Nutrition
Medical-Surgical Nursing-|
Mental Health Nursing
Child Health Nursing
Midwifery & Gynecological Nursing
Practical

>
>
>
>
>
>
>
>
>




Senior Assistant Nursing And Midwifery (vocational Course)

Course Code :VCsy4 Eligibility :10th

» BioSciences
% Anatomy & Physiology
% Microbiology

» Behavioral Sciences

% Psychology

% Sociology
Nursing Foundations

% Fundamentals of Nursing

% Firstaid
Community Health Nursing
Environmental Hygiene
Health Education & Communication Skills
Nutrition
Medical-Surgical Nursing-|
Mental Health Nursing
Child Health Nursing
Midwifery & Gynecological Nursing
Medical-Surgical Nursing I
Co-curricular activities
Community Health Nursing-Il

A\

Nursing Administration & Ward Management
Practical

VVVVVYVYVVVYVYVVYVYYVY




CSE (Certificate in Spoken English)

Course Code :VSE11 Eligibility :10t

5 eslo =
» Spoken English 4 SpokenEngllsh
A ﬁ

SLE (Spoken and Learning English)

Course Code :VSE12 Eligibility :10t

» Spoken English
» English Grammar
»  Writing Skills

SPOKEN
ENGLISH




WD (Web Development)

Course Code :W1a1

>
>
>
>
>
>

HTML

CsS

PHP

MY SQL
JAVASCRIPT
PROJECT

7

/

AWD (Advance Web Development)

Course Code :W12

VVVYVYVVYVYVY

HTML

CSS

PHP advance
MY SQL
JAVASCRIPT
jQuery
WordPress
ASP.NET

LIVE PROJECT

Duration:12 M Eligibility :10t™

WEB
Development ..,

N

e
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CDM (Certificate In Digital Marketing)

Know Your Computers
Let’s Experience Windows
Office Package

World Of Internet
Optimization Techniques
Create Your Own Blogs N0L0GYc
Brand Building On Digital Platform , etlng
Effective Marking Through Mails § BRANDING | PLACENENT e
Trending Marketing On Smart Phones
PPC

Google Ad Sense

Web Hosting

YouTube Master Class

Word Press

Content Marketing

DDM (Diploma in Digital Marketing)

Digital Marketing Introduction

Digital Marketing vs Traditional Marketing
Website Planning Process

Search Engine Optimization

Google Ad Words & Online

Display Advertising
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Online Display Advertising M;I\)||2(|;(IE'I|'\|I|-\|G

Email Marketing
Lead Generation for Business

Content Marketing / e \
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Social Media Marketing MAKKETING
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DIPLOMA IN FULL-STACKWEB DEVELOPMENT

HTML
Advance CSS FULL STACK
PHP advance WEB DEVELOPMENT
MY SOL : Learn By Building 40+ Apps
JAVASCRIPT

jQuery
WordPress
ASP.NET

LIVE PROJECT
Node.js

React JS
Python
Bootstrap

CDR (Certificate In Digital Rise)

by real world apps. 40,
s to skills for pers across dg
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» KnowYour Computers

» Let's Experience Windows

» Office Package

» World of Internet

» Optimization Techniques

» CreateYour Own Blogs

» Brand Building on Digital Platform

» Effective Marking Through Mails B e B

» Trending Marketing on Smart , & CONTENT P aal
Phones | - MARKETING ) §

>  World of PPC W Ll

» Google Ad Sense

» Web Hosting

» YouTube Master Class

» Word Press

» Content Marketing




AUTO CAD, 2D, 3D (D16)

STAAD PRO

DIGITAL MARKETING (W15)

TRAINING

HARDWARE & NETWORKING (HN11)

MOBILE REPAIRING (MM11)

SPOKEN ENGLISH (VSE11)
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CORPORATE SPOKEN ENGLISH

BRIDAL MAKEUP

PROFESSIONAL MAKEUP

JUNIOR COURSE

% JUNIOR SPOKEN ENGLISH
ABACUS PLUS (PRETO L8)

% ADVANCE JUNIOR COMPUTER (L2 TO L6)
» SCHOOL COMPUTER (WB, CBSE, ICSE) (J11)




